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The year is 2039.    Throughout the industrialized world, all manufacturing processes have become completely 
automated.    Computerized factories produce millions of consumer products every hour without any human 
intervention, as if by magic.    Inundated by cheap commercial goods and free from virtually all manual labor, 
most people live lives of mindless comfort. 

Unfortunately, the ultimate conclusion of the Industrial Revolution precluded a revolution in software design.    
Design of factory machinery far outstripped the design of the computer software which ran it.    As a result, the 
programs which automate manufacturing processes are prone to fail. 

This has had dire consequences in the past.    In 2028, an epidemic of vandalism and truancy swept over New 
York's youth following the breakdown of automation systems at a factory producing popular breakfast cereals 
there.    Similarly, in 2033, widespread rioting broke out in Seattle when the local coffee grinding factory and 
video game factory simultaneously went offline for two days.    These are only a few of the worst examples. 
Most of the population has come to base its existence on consumption, and such violent reactions almost always
accompany any interruption in the supply of desired items.

For this reason, it is critical that failing factories remain in operation with the help of special technicians known 
as EFASTs (Emergency Factory Automation Support Technicians).    EFASTs are gifted individuals who can 
manually control a factory's operations.    If they are able    keep a factory running at full capacity for a normal 9 
to 5 workday, corporate programmers usually have enough time to dig through decaying stacks of aging code to
figure out what is wrong with the automation routines.    EFASTs at first were hired and trained privately, but in 
2037 they formed a collective under the banner FACCOM (Factory Automation Control Compensation).    All 
EFASTs now receive their assignments and paychecks through FACCOM.

The potential rewards for EFASTs    are great.    Corporations which contract for an EFASTs    services are 
prepared to pay dearly for the maintenance of their production centers.    Depending on the complexity of the 
assembly process and the levels of production demanded, an EFAST stands to make thousands or even tens of 
thousands of dollars for a single day's work.

With these rewards, however, come great stresses.    Some EFASTs    have been driven to the brink of insanity 
because manually running a modern factory entails placing one's mind in many places at once.    The EFAST 
must simultaneously direct many components along conveyor belts and through networks of pipes to be sure 
that they are assembled together correctly.    In a population softened by material luxury, minds sharp enough for
the task are rare.

Even so, job security is a term unknown to the EFAST; in the interest of maintaining the integrity and reputation
of the team, failure to meet the production quota on any assignment results in immediate dismissal from 
FACCOM.
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Factory requires a Macintosh Plus or better running System 6.0.5 or later and a hard drive with approximately 
1.3 megs of free space.    Factory’s memory requirements vary depending on the color mode you choose (See 
“Technical Notes” for more information).

Before you begin, you should back up your Factory master disk.    Keep your master and backup disks locked.    
Refer to your Macintosh Documentation for help on copying files and locking disks.

• Although there is no copy protection on the Factory disk, you are only allowed to make one copy of it for 
yourself for backup purposes.    Making copies for others is illegal and unkind.

To install Factory on your hard drive, insert the disk and double click on the ‘Factory Install’ icon.    Follow the 
instructions which appear on the screen.

Factory must be played in either Black & White, 16 colors, or 256 colors.    256 colors is recommended on color
Macs.    Once you have begun Factory, do not change the number of screen colors.    Refer to your Macintosh 
Manual for help on changing the number of screen colors on color-capable Macs.    

To begin playing the game, double-click on the ‘Factory’ icon.

Factory contains a tutorial which will help you learn how to manipulate elements in the factory and assemble 
product components.    This is probably the best place to start.    To begin the tutorial simply select Tutorial from 
the Game menu.

The tutorial will step you through a sample workday.    Each step contains a prompt to click somewhere and an 
explanation of what is happening and why.    If you read each explanation carefully, you should get a good sense
of how Factory is played.

• To abort the Tutorial, click on the black status bar at the top of the screen (where the menu bar normally is) 
and select Call it a day or Retire from the Game menu.

Once you have gone through the tutorial, you're ready to begin playing Factory.    The first thing you must do is 
open the month you wish to play.    Factory includes the month of ‘December,’ and you can also create your own
months later.    (See “The Editor” below).

To open a month file, select Open on the File menu.    You will be presented with a standard Macintosh dialog 
for opening files.    Select the file containing the month you wish to play; in this case the month is ‘December.’    
Once you have a opened a month, you're ready to begin play.    
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• You can also open a month automatically by opening or double-clicking on it in the Finder before starting 
the Factory application).

Select Begin from the Game menu.    You will be asked to enter your name and, optionally, a check number.    
Entering check numbers is a way to advance past workweeks you have already completed.    For now, leave it 
blank. Click on That's me when you've entered your name; for now, just leave the check number blank so that 
you will start on the first workday. 

Before you begin each workday, you will be shown a calendar.    The first day will flicker, indicating that it is 
the current workday.    It will also show a picture of the product which you will be manufacturing on this day.    
The days which you have yet to work contain question marks.

To the right of the calendar is the name of the company which has contracted your services through FACCOM.   
Below this is a description of the product you will be assembling, as well as some hints on how to do so.    When
you are done with the calendar, click on the Go to Work button.

Next, you will be shown the Assembly Guide for the current workday.    This will give you a graphic description
of the process by which the day's product will be assembled. Arrows indicate how you must combine various 
components into the finished product, which is outlined.    By convention, the flow of the Assembly Guide is 
from left to right.    After you have studied the guide, click on the OK button.    You can get another look at the 
Assembly Guide at any time by using the selection on the Game menu.

Finally, the conveyor belts start rolling.    At the top of the screen, in place of the menu bar, you will see the 
status bar.    To the left is the name of the company which own the current company.    Next is your current quota
(the number of finished products you have to assemble during this day).    To the right of the quota indicator is 
the shipment status.    The first number is the number of items you have sent into the truck (initially 0), and the 
second number is the number of items the truck can hold.    Finally, on the far right is an indicator of the current 
conveyor belt speed.

If you click on the status bar, the game will be paused and the menu bar will reappear.    To leave pause mode, 
click on the playfield.

• When the game is playing (the menu bar is not visible), you will not be able to switch applications, and no 
system background tasks will be performed.

You will notice that you can now use most of the items on the Game menu.    The functions of these items are 
described below.

Pause/Resume Enter or leave pause mode.
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Call it a day End the current workday and (hopefully) go on to the next.    Make sure you've met 
your quota!

Retire End the game.

Assembly Guide Display the Assembly Guide.

Speed Up & Down Increase or decrease conveyer belt speed.

Sound Toggle sound effects on and off.

• Many menu selections have Command key shortcuts.    You can use these shortcuts even when the game is 
playing and the menu bar is not visible.

You have to find a way to piece them together into finished products.    The Assembly Guide will have given 
you the general idea of how this is done, but now you have to analyze the factory's layout to figure out the 
mechanics of it.    The following section should help you by describing exactly what function various parts of 
the factory fill, and how they are used to piece move components around and piece them together.

A factory consists of many fixtures which serve different purposes in assembling components.    The function of 
most of these is fairly intuitively obvious: components move around on conveyor belts, fall down through pipes,
rise up on elevators, and so on.    Use of some of the fixtures, especially those which are used to combine 
components together, is less obvious.    A description of these follows.

• If you are using color, the factory fixtures illustrated below will appear somewhat different on your screen.

There are four specially-labeled pipes which serve special purposes.    The Supply Pipe is where all components 
enter the factory.    The Recycler Pipe sends components back through the Supply Pipe.    The Trash Pipe is used 
to eliminate waste; your paycheck will be penalized for trashing usable components.    Finally, the Truck Pipe 
sends products to the truck for shipping.

Supply Pipe Trash Pipe

Recycler Pipe Truck Pipe
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A number of other fixtures in the factories exist to help you assemble components into finished products.    
Many of these are turned on and off by simply clicking on them.    Controls of this type are described below.

When a Drop Box is on, components traveling into it along a conveyor belt will drop through its bottom; when 
it is off, components will continue along the belt normally.    Similarly, an Elevator Switch sends component up 
through to an elevator if its is on, or otherwise leaves the component alone.

On Off

Drop Box

Elevator Switch

A Press is used to activate the fixture above it to combine two components.    When a component reaches a Press
which is on, it stops while something is done to it.    The operation performed depends on what fixture lies 
above, which will be a Gate, Storage Tank, Dispenser, or Gadget.    (See below).    A press which is off has no 
effect on components traveling through it.

On Off

Press

A Gate which is on (closed) acts as a temporary holding area for a single component.    If the Gate is turned off 
(opened) the object is released.    If the Gate contains a component and is above a Press which is on, a second 
component traveling through the Press will automatically open the Gate and cause the two components to be 
combined.    For example: a pair of shoes is waiting in the Gate which is above an active Press.    If a box comes 
along and enters the press, the shoes will fall into the box.

On Off

Gate

An Oven and a Washer are used to alter components when they are turned on.    If they are off, components will 
pass through them with no effect.

On Off

Oven

Washer
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Storage Tanks can hold up to nine of any particular component.    If a storage tank is above an active Press and it
contains an item, it will release the item for combining just like a gate.    (In some cases, a packet of 2 or 3 
components is required for this effect).    Items can also be manually released from a storage tank by simply 
clicking on it.    Storage tanks are labeled with a small picture of the component type which it is designed to 
store and a bar indicating how full the tank is.    If an incorrect component type is dropped into the tank, all 
items become trash and are released.

Storage Tank

Dispensers are used in conjunction with Presses.    They dispense various forms of matter on or into components
which pass below them onto an active Press.

Dispensers

Gadgets can also be used in conjunction with Presses to perform operations on components.    Alternatively, 
components might also pass through a gadget; in this case the Gadget functions much like an Oven except that 
it cannot be turned off.

Gadgets

The day ends when you select Call it a day from the Game menu, when the truck shipment is full, or when the 
clock on the factory wall reaches 5 o'clock.    When this happens, you will be shown an evaluation of your 
performance.    If you successfully met your quota, you will advance on to the next day.    

If you fail to meet your quota, it's game over.    When the game ends, you will be shown a list of the 10 highest-
earning EFASTs for this month.    If you have become one of them, you will be notified at this time.    If you 
already were one of the top 10, your higher earnings will be displayed and you may move up in the rankings.

Every Friday, you will receive a paycheck.    You will see how much money you earned in the past week, and 
you will also notice that the check has a special code in the check no. space.    By entering this number in the 
space provided when you start a new game, you will be able to skip the days you have worked up until this 
point.    This means that you won't have to work a week over again once you finish it.    Your most recent 
password is saved for you and automatically entered when you start a new game.    If you change to a different 
month, or play with a different name, the old password will be lost, so you may want to jot it down on a piece of
paper.

If you manage to complete all of the workdays in a month, you will be congratulated and be able to see all of 
the products you have assembled flowing out of the factory.    In addition, the editing password on the month 
will be removed, allowing you to tinker with the Factories and Components as you desire.
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• When you approach a factory for the first time, take a minute studying the layout and the Assembly Guide to
formulate a strategy.

• Use the speed control to your advantage.    If things get too complicated, slow down and figure out what you
need to do.

• Work quickly but don't rush.    There will usually be more than sufficient time to fill your quota if you work 
at a steady pace.

• Learn to think ahead and be able to concentrate on assembling components in different places at the same 
time.

• Don't be afraid to throw items in the trash.    You will lose money, but having fewer objects floating around 
allows you to concentrate on getting finished products assembled.    You may even want to dump stray 
objects together in a temporary trash area.

• Remember that the shipment counter is merely a raw count of how many items you've loaded into the truck. 
Be sure enough of those are finished products before deciding to Call it a day.

• Write new check number codes down when you get them.    The back of this manual is a good place to do 
this.    It will be saved and entered for you automatically, but its a good idea to have it written just in case.
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Factory comes with a    ready-to-play month, December, but you can also use the built-in editor to create your 
own months.

To start from scratch, simply select New from the File menu.    You will be given a standard file dialog for 
creating files.    Note that the file name is taken to be the name of the month, so a name such as January, August,
or Thermidor is suggested.

You can also open an existing month for editing, but you may be required to enter a password before making 
changes.

Once you have a month open, you can begin constructing factories and designing products by selecting 
Calendar... or Components... from the Edit menu. 

• Any changes you make to the month are saved automatically.

Before you start building factories, you have to decide what sort of products you are going to build in them.    If 
you select Components... on the Edit menu, you will be able to create and edit your own product components.    
A component palette will appear with which you can view components and select them for editing.

Components are grouped into families of 15, and each workday has a single family associated with it.    Thus, a 
family must contain all of the components and combinations of components (including trash and the finished 
product) which will be used in a given workday.    You can page through the families by clicking on the left and 
right arrow buttons on the selection palette.

For example, consider the components required for the factory in which shoes are placed in a box.    Five 
components are necessary: the shoes, the box, a box containing shoes (the finished product), a trashed pair of 
shoes, and a trashed box.

Each component has two parts: an image and a combination table that defines how the component interacts with
other components.    These are described in the sections which follow.
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While selecting a component to edit, the Components menu appears on the menu bar.    It contains the following
commands:

New Family Create a new family of 15 blank components.

Copy Template Place a PICT containing a template of all component images in the currently selected 
family on the Clipboard.

Paste Template Copy a PICT component template onto images of currently selected family.    (See 
below for more information).

When you are done editing components, click on the OK button on the component palette or press Return.

Factory contains a simple graphics editor (described in the next section) for drawing component images, but 
you may want to use your own paint program.    Graphic templates provided a simple way of transferring 
families of component images between Factory and other applications.

A template is simply a picture which contains a grid of 15 cells corresponding to the items on the component 
palette, each containing a component image.    When you choose Copy Template from the Component menu, a 
template is placed on the Clipboard.    You can then switch to a painting application and paste in the component 
template.

• If you are running under System 6.x and are not using MultiFinder, you will have to copy the template into 
the Scrapbook, quit Factory, open a painting application, and paste the template in from the Scrapbook.

For more information about the Clipboard, Scrapbook and switching applications, see your Macintosh Manual.

Once you have the template in your paint program, you can edit the images within the cells.    You should use 
the Apple color palette (16 or 256 colors) if possible.

When you are done editing the images, select the entire template (including the frame) and copy it.    See your 
paint program manual for more information on selecting and copying.

Now, switch applications back to Factory and choose Paste Template.    The new images will appear on the 
palette and you will be asked to verify that they are acceptable.    If you do so, the images become the images for
the current family.

• If you leave a cell in the template blank (all white pixels within the frame), it will not be pasted onto the 
component family.    Whatever image existed in the corresponding place will remain undisturbed.

• Make sure the template is exactly the same size it was when you initially pasted it.    If it is not, Factory will 
not recognize it as a valid template when you choose Paste Template.
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In addition to using a paint program as described above, you can draw component images with Factory's built-in
paint editor.    If you click on a component in the component palette, the Image dialog appears.

You will see a fatbits (blown-up) picture of the component's image and an actual-size image, as well as a few 
painting tools.    If you are familiar with other Macintosh painting programs, use of these tools should come 
naturally to you.    The tools can be selected by simply clicking on them:

Pen Tool Draws where you click in the component image.    

Eraser Use this tool to erase dots in the image.

Selection Tool You can use this tool to manipulate rectangular sections of the image.    (See below).

Color Sampler Use this tool to sample a color from the image and make it the current drawing color.    To
access this tool, hold down the Option key when the pen tool is activated.

If you are using color, you can select a drawing color from the palette on the right of the image.    The current 
drawing color is displayed in a box below the Eraser tool.

The selection tool allows you to manipulate rectangular sections of the image.    To use it, click and drag across 
the part of the image you want to select. A frame will show you how much you have selected.    When you 
release the mouse button, the selection region will be outlined.    

You can use commands from the Edit menu in conjunction with the selection.

Undo Undo the last drawing operation performed.

Cut Deletes the selection and places it on the Clipboard.

Copy Places a copy of the selection on the Clipboard.

Paste Copies the contents of the Clipboard onto the image.    If a selection is active, the 
Clipboard image is scaled to fit inside the selection.

Clear Deletes the selection.

Select All Select the entire component image.

You can also move a selection around by dragging it (a hand appears to indicate that you can grab the selection).

• If you hold down the Option key when you go to drag a selection, a copy of the selection will be left in its 
original position.

You can copy and paste selections within the same image, between different images, or between applications 
(using the method described above under "Copying and Pasting Templates").
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If you check the box at the bottom labeled Waste, the current component will be considered waste during game 
play.    If you click on the button labeled Combinations, you will move to the Combinations dialog (see 
"Creating Combination Tables" below).

When you are done editing the component image, click on the OK button or press Return.

If you click on the Combinations button on the image editing dialog, you will go to the combination table 
dialog. 

• You can skip directly to the combination table by holding down the Option key while you click on a 
component in the component selection dialog.

A component's combination table determines how it combines with other components. Components combine by
a simple rule: A + B = C.    A is the current component, while B and C can be set in the combination table.    B is 
the additive component which might be another component which drops onto a from a gate or storage tank, or it
might be a layout fixture through which the component passes.    C is the resultant component.

For example, if the current component is the box from the previous shoe example, the additive component 
would be a pair of shoes, and the result would be a box with shoes inside of it.    (You might want to distinguish 
the full box from the empty box by drawing it as a closed box or with a company logo on it.)

To place an item in the combination table, simply click on the desired cell.    You will be given a palette of 
components to choose from.    If you are clicking on an additive cell, you can alternatively choose from a page 
of layout fixtures which you may want to affect the component.    For example, a pie might turn into a baked pie
if it is combined with (goes through) an oven.

There are four possible entries on the combination table.    A fifth entry has a question mark for the additive 
component.    This is the default combination, representing any combination not provided for in the table.    This 
is normally a trash component, by convention the last component in the family.    Leaving the default resultant 
as some kind of trash insures that components will only be able to combine in the ways specified in the 
combination table.

If you check the box at the bottom labeled Waste, the current component will be considered waste during game 
play.    If you click on the button labeled Image, you will move to the Image dialog (see "Editing Component 
Images" above).

When you are done editing the combination table, click on the OK button or press Return.

Once you have created a family of components, you can proceed to create a factory which will assemble them.
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If you select Calendar... on the Edit menu, Calendar dialog will appear.    If you are editing a new month, the 
calendar will be empty; otherwise, the calendar will display products on workdays much as it does in the course 
of normal play.

Below the calendar are 5 buttons which allow you to change aspects of the current month: Password, Days, 
Move, Edit, and Test,    Their functions are described below.

When you are done editing the calendar, click on the OK button or press Return.

If you click on the Password button, you will be able to set password protection for the current month. 

Once a password has been set for a month, no one will be able to access editing functions without entering the 
password first.    This prevents players from altering factories to make them easier.    When a player successfully 
meets their quota for the last day of the month while playing the game, the password protection is removed.

Newly created months do not have passwords and you probably won't want to set it unless you're ready to 
distribute your month to others.    If you set a password and want to remove it, simply delete the text if the 
Password text box.

• Warning: If you set password protection, DO NOT forget it!    Writing it down in the back of this manual    
is advisable.    Note that passwords are case-sensitive.

If you click on the Days button, you will be able to set the first and last days for the current month.

You will first be asked to click on the day you wish to be considered the first of the month and then that which 
should be the last day of the month. 

• You cancel any such operation which asks you to select a day on the calendar simply by clicking anywhere 
outside of the calendar.

Although normal months have between 28 and 31 days, Factory's months can be of any length up to 33 days.    
Note that since no work is done on weekends, so this means that there are a maximum of 25 actual workdays (5 
weeks x 5 days) in a given month.

If you shorten a month, some workdays may disappear .    These workdays are not erased, but are simply not 
displayed in the editor or during game play.    This allows you to temporarily hide some workdays which may be
under development.    To re-display them, simply lengthen the month using the Days button.

If you click on the Move button, you will be able to alter the order in which workdays appear on the calendar.
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You will first be prompted to click on the workday you wish to move and then for where you want it moved.    
Note that both of these must be between the first and last days of the month.

• Normally, the day you select will be inserted at the specified position, but if you hold the Option key down 
during this operation, the two selected days will simply be swapped.

If you click on the Test button, you will be able to select a workday you wish to take on a trial run.

Normal game play will begin on that workday.    When the workday ends for whatever reason, you will be 
returned to the calendar dialog.

If you click on the Edit button in the Calendar dialog, you will be asked to select a workday to edit.

Once you do so, the Workday dialog will appear.    It displays information about the selected workday such as 
company name, goal product, quota size, shipment size, and difficulty rating.    All of these can be altered as 
described below:

Company Name is simply the name of the company for which the player works on the current workday.    The 
default company name is Acme.

Goal Product displays what is to be produced in the current workday.    To alter it, simply click in its box, and 
you will be given the selection palette.    Here you may choose any component from any family of components 
you have created.

• Once you choose a component as a goal for a particular workday, its family becomes the family for the 
workday.    If you later change to a goal product from a different family, you will probably have to redo most
of the settings for the workday.

If no product has been selected, or if you press Clear on the selection dialog, a gray square is displayed.    A 
workday will be ignored during game play if no product has been selected.

Quota and Shipment display the current workday's quota and the maximum shipment sizes.    The quota is the 
number of finished products the player must get into the truck in order to advance to the next workday; the 
shipment is the number of items of any kind that will fit in the truck.    These should be between 1 and 30, and 
the quota should be less than the shipment.    

Difficulty displays the difficulty rating of the current workday.    This effects how much the player is paid or 
penalized at the end of the day - a higher difficulty means higher stakes.    It should be between 1 and 10.

• If you enter unacceptable values into any of the fields, they will be adjusted when you leave the dialog.
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The workday dialog also has six buttons which allow you edit other aspects of the workday:    Layout, Storage, 
Inputs, Text, Assembly.    These functions are described in the sections which follow.

If you click on the Layout button in the Workday dialog, you will be able to edit the layout of the current 
workday's factory layout.

The factory layout will be displayed along with a palette of factory fixtures.    If you click on a fixture in the 
palette, it becomes the current fixture (which is    displayed in the topmost palette cell).    This fixture will be 
placed in any layout grid cell on which you subsequently click.    There are several pages of fixtures which you 
can flip through using the palette's arrow buttons or by using selections on the Layout menu .

• To make a fixture in the layout the current palette fixture, hold the Option key down and click on the desired
layout item.

• To erase an layout grid cell, hold the Shift key down and click on it.

• You can fill or erase a multiple cells by holding the mouse button down while moving the cursor.

• If the fixture palette is covering a part of the layout which you want to work on, move the palette out of the 
way by dragging on its title bar.

Placing Factory Fixtures

Many fixtures contain a conveyor belt, the direction of which is indicated by an arrow on the fixture.    (If you 
are running in 256 color mode and select the Animate Editing option on the Layout menu, you will actually see 
the belts moving in the correct direction). Selecting Change Belt Direction from the Layout menu will switch 
the direction of all belt-fixtures in the palette, allowing you to place conveyor belts going in both directions.    

• You can also switch directions by clicking on the current fixture in the fixture palette.

You can place one truck at the left or the right side of the screen by clicking on the little truck icon (located at 
the bottom of the Gates & Girders fixture page).    The direction of the truck in the palette toggles along with the
conveyor belt direction. Note that the entire truck will not be drawn on the editing screen.    Rather, the truck 
icon will be drawn at the point at which components actually enter the truck.    Note that unlike other fixtures, 
you cannot control where the truck is placed; it goes in the same spot regardless of where on the layout you 
click.

Factory layouts have two layers, a foreground and a background.    Fixtures in the background have no effect on 
game play; a few pages of background fixtures are provided to add variety to factory layouts.    Some 
background fixtures cannot be placed in a two-square margin around the sides and bottom of the layout.
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The editor enforces the integrity of factory layouts. This means that you will not be able to save layouts which 
might cause components to behave in unnatural ways.      For example, objects shouldn't be able to fall off of the
bottom of the screen, and they shouldn't find conveyor belts going in opposite directions.    Note that the editor 
is concerned only with paths along which components could conceivably travel.

When you finish editing the factory layout, a check will be made to see if the layout is acceptable.    If it isn't, 
you will    be forced to either continue editing the layout or revert to the layout before you began editing.    You 
will not be able to exit with (and thereby save) an invalid layout.    If you select Check Layout from the Layout 
menu, the editor will indicate exactly what and where the problem is.

In general, a layout must meet the following criteria:

• It contains no unnatural component paths.

• It has a path leading from the supply pipe to the truck or a truck pipe.

• It contains exactly one clock and one supply pipe.

• It has fewer than 15 storage tanks.

While editing the Assembly Guide, the Layout menu will appear on the menu bar.    It contains a list of the 
fixture pages which allow you to turn directly to a specific page in the fixture.    It also contains the following 
commands:

Foreground Toggles display of the foreground layer.

Background Toggles display of the background layer.

Animate Editing Toggles the animation of conveyor belts during editing.    This option is only available
when using 256 screen colors.

Change Belt 
Direction Toggles the direction of conveyor belts in the palette.

Check Layout See where problems lie in the current layout.

Revert Layout Restore the layout to how it was when you began editing it.

Clear Layout Start over with a blank layout.

When you are done editing the layout, click on the OK button on the fixture palette or press Return.

If you click on the Storage button in the Workday dialog, the Storage Tanks dialog appears.    This allows you to
set storage tanks to store components.



16    Factory: The Industrial Devolution

The dialog displays five storage tanks and the type of component each one stores.    To set a tank to store a 
particular component, simply click on the cell adjacent to it and choose from the components on the component 
selection dialog.    Once you do, the tank will be labeled with a small picture of the component which it stores.

• Although each workday is limited to a maximum of 5 different types of storage tanks, a factory layout can 
have as many as 15 total storage tanks, regardless of type.

You can also set the number of items which are to be considered a unit within the tank.    This will usually be 1, 
but can be set to 2 or 3.    Setting the number to 2 means that the storage tank will not activate a press below it 
until 2 items have been placed in the tank.

When you are done setting the storage tanks, click on the OK button or press Return.

If you click on the Inputs button in the Workday dialog, the Input Queue dialog will appear.    The input queue 
sets the order in which components flow into the factory through the supply pipe.    

You will be presented with a dialog containing ten cells which represent a position on the input queue.    The 
component in the leftmost cell will enter the factory first, the next one will be next, and so on.    The queue 
'wraps' around from the right end and starts at the left again.

You can place components in the cells by clicking on them and choosing from the component palette. 

You can also set the level of randomization in the input queue with the radio buttons on this dialog box.    With 
no randomization, components will be chosen from the input queue in sequence from left to right.    As the 
randomization increases, the likelihood of components appearing in the specified queue order decreases.

Empty cells in the queue are ignored.    You can make a cell empty by clicking on it an choosing Clear from the 
component palette.

When you are done setting the input queue, click on the OK button or press Return.

If you click on the Text button in the Workday dialog, the Introductory Text dialog appears.    This allows you to
edit the text which appears to the left of the calendar at the beginning of the workday.

The text appears in two sections which should be kept fairly brief.    By convention, the first section should 
describe the company and product of the current workday, and the second should offer tips on how the player 
should assemble the components.

• All text entries are limited to a maximum of 255 characters.    However, it is unlikely that more than this 
number would fit in the spaces provided.

When you are done editing the text, click on the OK button.
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If you click on the Assembly button in the Workday dialog, the Assembly Guide dialog appears for you to edit.  
The Assembly Guide visually explains to the player how components should be put together during the current 
workday.    By convention, the logical flow of the guide should be from left to right.

You will be shown the grid of cells which comprise the Assembly Guide and a selection palette.    If you click on
a component in the selection palette, it becomes the current component (which is displayed in the topmost 
palette cell).    This component will be placed in any assembly grid cell on which you subsequently click. 

• To make an item in the Assembly Guide the current palette item, hold the Option key down and click on the 
desired assembly item.

• You can paint or erase a multiple cells by holding the mouse button down while moving the cursor.

• If the selection palette is covering a part of the Assembly Guide which you want to work on, you can move 
the palette out of the way by dragging on its title bar.

There are two alternate pages of assembly components which contain cues to assist you in communicating the 
way in which components should be assembled.    Click on the palette's arrow buttons to switch pages or use the
selections on the Assembly menu as described below.

While editing the Assembly Guide, the Assembly menu will appear on the menu bar.    It contains selections for 
quickly accessing any of the three pages in the assembly palette as well as the following commands:

Shift [direction] Nudges all elements on the guide in the specified direction.    Use to center the guide 
or make room for additional instructions.

Clear Assembly 
Guide Start over with a fresh Assembly Guide.

• Warning: If you nudge items off of the edge of the guide, they are immediately lost.

When you are done editing the Assembly Guide, click on the OK button on the component palette or press 
Return.

Factory's editor allows you to create your own month files.    If you choose to do so, you are welcome to share 
the file with others.    You should probably set password protection on the month so players can't cheat by 
editing their way through harder levels.

If you do distribute a month file, you must not do either of the following:

• Distribute any of the files which came on the disk in the Factory package.
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• Remove or alter copyright notices embedded in the month files.

Doing either of these is a violation of you license agreement for the use of Factory.    If someone else wants to 
play a month you have created, they will have had to have registered their own copy of Factory.

• You must have the fonts 10 & 12 point Geneva and 12 point Courier installed in order for all of Factory’s 
text to display correctly.    Refer to your Macintosh Documentation for help on installing fonts.

• There are three ‘Graphics”’ files installed with the game, but you only need the one corresponding to the 
color mode in which you will be playing.    For example, if you know that you are going to play only in 16 
color mode, you can throw the files ‘Black & White Graphics’ and ‘256 Color Graphics’ in the trash.

• You can also safely throw away the ‘Sound’ file if you are planning on playing without sounds. 

• If you experience System Errors or other unusual behavior while running Factory, try disabling some or all 
of you INITs.    Refer to your Macintosh Documentation for more information.

• If you’re playing in Black & White or 16 color mode, you can reduce the memory allocation in Factory’s 
Get Info window; the memory size suggested is for users running in 256 color mode.    If you’re playing in 
Black & White, you can set the memory size down to 600k; in 16 color mode you can reduce it to 800k.    
Setting smaller memory sizes than are suggested here will probably make your system crash.    Unless you 
are experiencing memory shortages, you should probably keep the default setting of 1200k.

• I can be reached via email at pcal@agora.rdrop.com.    If you can access the World Wide Web, go to 
http://www.rdrop.com/~pcal/factory for the latest information.


